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This chapter introduces the Macintosh operating system, which is used
to run AppleWorks. How to use the mouse, windows, and dialog boxes
are discussed. Proper handling and initializing of diskettes and making
backups of files are also introduced.

 2.1 Operating Systems
All microcomputers run software that allow the user to communicate

with the computer using the keyboard and mouse. This software is called
the operating system. When the computer is turned on, the operating sys-
tem software is automatically loaded into the computer’s memory from
the computer’s hard disk in a process called booting.

The operating system for Macintosh computers, simply referred to as
Mac OS, has a graphical user interface, or GUI (pronounced “gooey”). The
Mac OS GUI uses icons, menus, windows, and dialog boxes to allow the
user to work with applications software, such as AppleWorks. Icons are
small pictures on the screen that represent items in the computer and
perform various tasks. Menus contain a list of commands that are used to
perform specific tasks and actions. A window is the area on the screen
that contains an open application or document. A dialog box allows the
user to choose and enter information that is needed to complete an ac-
tion. A document is the material that you create using an application, and
a document stored on disk is called a file.

Through the use of windows, multitasking is possible. Multitasking al-
lows for more than one application to run at the same time. For example,
word processor and spreadsheet applications can run simultaneously.
Mac OS also supplies applications that allow you to easily work with the
operating system.

Mac OS 9
This chapter briefly introduces
the Macintosh operating
system, Mac OS 9. Many of
the concepts and procedures
introduced in this chapter are
compatible with older versions
of the Macintosh operating
system, often referred to as
System. AppleWorks 6 re-
quires System 8.1 or later.

iMac
Apple introduced its newest
computer, the iMac, in August
of 1998. The iMac’s monitor
and base unit are combined
into one translucent unit that
comes in a variety of vibrant
colors. One of the iMac’s key
features is its easy setup
which allows users to connect
to the Internet in just a few
minutes after plugging the
iMac in. The iMac has be-
come a huge success and is
used by millions of personal
computer users today.
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 2.2 Using the Mouse
A GUI program requires an input device called a mouse, which is used

to perform a variety of tasks and looks similar to:

The mouse

When the mouse is in use, the mouse pointer is displayed on the screen.
One common shape of the mouse pointer is an arrow:

Ú
The mouse pointer

The mouse pointer may change shape depending on the current opera-
tion being performed. For example, a watch shape (Æ) is displayed when
the computer is performing a task and cannot accept additional input at
that time.

Sliding the mouse on a flat surface causes the mouse pointer to move
on the screen. Slide the mouse to the left and the mouse pointer moves to
the left; slide the mouse to the right and the mouse pointer moves to the
right.

Moving the mouse to place the pointer on an icon or other object is
called pointing. In this text, when we say to point to an object on the screen,
we mean to move the mouse until the mouse pointer is placed on the
object.

An object on the computer screen can be selected by pointing to it, press-
ing the mouse button, and then releasing it quickly. This type of selec-
tion is called clicking. When we say to select, or click on, an item, we
mean to point to it and then press and release the mouse button.

A special form of clicking is double-clicking. As the name implies,
double-clicking means to point to an object and then press the mouse but-
ton twice in rapid succession.

The last mouse technique is called dragging. When we say to drag, we
mean to press and hold the mouse button while moving the mouse. In
some cases, an object can be moved by dragging it. When we say to drag
an object, we mean to point to it and then hold down the mouse button
while moving the mouse. When the object is in the desired location,
release the mouse button.

pointing

double-clicking

clicking

dragging

Balloons
When pointing to an object
that performs an action and
pausing for a few seconds, a
balloon may appear near the
pointer. The balloon provides
information about the object
and often describes what
action(s) the object can per-
form. Balloons can be shown
or hidden using the Show

Balloons or Hide Balloons

commands from the Help

menu at the top of the Desk-
top. The Desktop is intro-
duced in the next section.

selecting

moving the pointer
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 2.3 The Mac OS GUI
The Mac OS GUI contains features that allow you to easily use the

operating system and applications software. When the Mac OS is run-
ning, the computer screen is referred to as the Desktop:

Apple menu

Application menu

icons

Menu bar

The Mac OS Desktop

• Apple menu ( ) contains a list of available Mac OS applications.

• Menu bar contains the names of pull-down menus. Pointing to
a menu name and clicking the mouse pointer once displays the
menu’s commands. Pointing to a command highlights that com-
mand. Clicking the pointer while the command is highlighted
selects that command.

• Application menu ( ) is used to switch between open
applications.

• Icons are used to represent items in the computer, such as hard
disks, files, and programs. Icons are double-clicked to perform
tasks and run programs.

Arranging Icons
Icons on the Desktop can be
dragged to new locations.
This allows you to arrange the
objects on the Desktop the
way you want them to appear.
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 2.4 Using Windows
Applications, as well as most documents, are displayed in their own

window. Most windows have similar features:

Close box

Title bar

Zoom
box

scroll bars

Size box

• Title bar displays the name of the application or document. A
window can be moved by dragging its Title bar.

• Close box ( ) closes a document window or ends the applica-
tion and removes the window from the screen.

• Zoom box ( ) automatically resizes the window so all of the
contents are displayed (if possible) or returns the window to its
original size after it has been resized larger.

• Collapse box ( ) collapses the window so that only its Title
bar is displayed. If the window is already collapsed, clicking
this button will again display the entire window.

• Scroll bar is used to bring the unseen parts of the document
into view.

• Size box ( ) is dragged to resize the window.

Practice 1 ���������������������������
In this practice you will view the Desktop and resize a window.

!!!!! BOOT THE COMPUTER
Turn on the computer and, if necessary, the monitor. After a few seconds, the computer
automatically loads the Mac OS.

@@@@@ IDENTIFY THE PARTS OF THE DESKTOP
a. Identify the icons on the Desktop. How many icons appear on your Desktop?

b. Locate the Menu bar at the top of the Desktop.

##### VIEW THE APPLE MENU
a. Point to the Apple menu ( ) in the upper-left corner of the Desktop.

b. Click once on the Apple menu. A menu is displayed.

c. Click once on a blank portion of the Desktop. The menu is no longer displayed.

How to Use This Text
Throughout this text, new
commands and procedures
are introduced in a two-step
process. First, a command or
procedure is discussed. The
discussion is then followed by
a practice that leads you step-
by-step through an example of
how to use the command or
procedure. You will perform
the steps in the practices on
the computer. When perform-
ing a practice, do every step
in order as directed. Also, do
not skip any practices be-
cause many of them build on
previous practices. Skipping a
practice may mean that you
do not get the correct result at
the end of the next practice.
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$$$$$ DISPLAY A WINDOW
a. Double-click on the icon for the hard disk:

A window is displayed.

b. Locate the features of a window.

%%%%% MANIPULATE THE WINDOW
a. Drag the Size box ( ) in the lower-right corner of the window upwards and to the left. The

window is resized smaller.

b. Click on the Zoom box ( ) in the upper-right corner of the window. The window is auto-
matically resized larger so that all (if possible) of the contents are displayed.

c. Click on the Zoom box again. The window returns to the size it was before the Zoom box
was first clicked.

^̂̂̂̂ CLOSE THE WINDOW
Click on the Close box ( ) in the upper-left corner of the window. The window is closed.

 2.5 Using Dialog Boxes
A dialog box is used to supply the information needed to execute a

command. Dialog boxes have several options:

entry box button

default option
radio button

pop-up menu

• Pop-up menu displays a list of options to choose from by click-
ing on the arrows ( ).

• Button initiates an action when it is clicked.

• Entry box is used to type information that may be needed by a
command.

• Radio button ( ) is used to select an option; usually only one
of the set of radio button options may be selected at a time.
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• Default option is an entry or option that has already been se-
lected for you. For example, the Save button in the dialog box
on the previous page is the default button and has a thick solid
outline. If no other options are selected, the default options are
used when the Return key is pressed.

• Cancel button removes a dialog box without applying any
options.

• Check box ( ) is used to select or deselect an option; usually
any number of the set of check box options may be selected at
the same time. Note that there is no check box option in the dia-
log box shown on the previous page.

 2.6 Finder
Included with the Mac OS is an application called Finder that main-

tains the Desktop and the files and folders in the computer. The Finder
application is always running when the computer is on.

Folders store and organize related files and are represented by an icon
with the folder’s name:

Double-clicking on a folder icon displays the contents of the folder in a
window:

The contents of a folder are displayed by
double-clicking on the folder icon

The contents of a folder can be displayed in different ways using the
commands from the View menu on the Finder Menu bar. The folder win-
dow on the previous page displays the contents of the folder as icons.
Selecting the as List command displays information about files and fold-
ers in a list that includes the size and kind of document.

When you are finished working with the computer, it can be turned
off by selecting the Shut Down command from the Special menu on the
Finder menu bar.

Folders
Folders can contain other
folders. For example, you
could create a folder with the
name “Spring 2002” that
stores all files related to your
classes for the 2002 spring se-
mester. Additionally, you
could have subfolders for
each class that semester
stored in the Spring 2002
folder.
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 2.7 File and Folder Management
Finder simplifies the tasks of copying, moving, creating, and deleting

files and folders. Files and folders can be copied and moved using a
method called drag and drop. Copying a file leaves the original file in its
present location and places an exact copy in a new location. Moving a file
removes it from its present location and places it in a new location.

A file is copied from one location to another on the same drive (e.g.
from a folder on the hard disk to another folder on the hard disk) by
holding down the Option key and dragging the file’s icon to the new
location. When copying a file to a different drive (e.g. from the hard disk
to a diskette), then the Option key does not need to be pressed when
dragging the file to its new location.

A file is moved from one location to another by dragging the file’s icon
to the new destination. This method can only be used to move a file within
the same drive.

A folder can also be copied and moved using the drag and drop meth-
ods described above. All of the subfolders and files in the folder are also
copied or moved.

Commands from the File menu on the Finder Menu bar can be used to
create a new folder, make a file read-only, and create an alias.

A new folder is created by selecting the New Folder command from
File menu. A new folder icon with the highlighted name “untitled folder”
is displayed. An appropriate name can then be typed to replace the high-
lighted text.

A file can be made read-only to prevent it from being altered. A read-
only file cannot have changes made to it. A file is made read-only by
first selecting its icon and then selecting the General Information com-
mand from the Get Info submenu in the File menu. Selecting the Locked

check box in the Info dialog box makes the file read-only. The Info dia-
log box may then be closed by clicking on its Close box. A file can be
unlocked by deselecting the Locked check box in the Info dialog box.

A file or folder is deleted by dragging its icon over the Trash icon until
the Trash icon is highlighted, and then releasing the mouse button.

Renaming a file or folder replaces an existing name with a new name.
A file or folder is renamed by clicking once on its name, typing a new
name, and then pressing the Return key. Files and folders can have names
up to 31 characters including spaces. The colon (:) is not allowed in a file
name. A read-only file cannot be renamed.

Creating an alias to a file or application means to place an icon on the
Desktop that, when double-clicked, will display the file or start an appli-
cation. An alias to a file or application is created by selecting the icon
which represents the desired file or application and then selecting the
Make Alias command from the File menu on the Finder Menu bar. An
icon with the application or file name is displayed with the word “alias”
after it.

copying a file

moving a file

copying and moving a
folder

creating a read-only file

deleting a file or folder

renaming a file or folder

drag and drop

creating
a folder

creating an alias
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 2.8 Recovering Deleted Files
When a file is deleted it is not really removed from the hard disk; it is

stored in a location on the hard disk called Trash and the Trash icon ap-
pears filled:

When files are dragged to the Trash icon, it appears full

Therefore, deleted files can be recovered. A file is recovered by double-
clicking on the Trash icon on the Desktop, which displays a window with
recently deleted files. Dragging a file to the Desktop or to a folder
undeletes the file.

Files in the Trash are still taking up space on the computer’s hard disk.
Files can be permanently deleted so that there is more space on the hard
disk by selecting the Empty Trash command from the Special menu on
the Finder Menu bar. Finder will display a dialog box asking if you re-
ally want to remove the file(s) permanently. Selecting OK permanently
deletes the files stored in the Trash and frees up space on the hard disk.
Selecting Cancel leaves the files in the Trash.

 2.9 Using Diskettes
After inserting a diskette into the drive, an icon for the diskette is shown

on the Desktop:

The contents of the diskette can then be viewed by double-clicking on
the diskette’s icon.

A diskette is removed from the drive by dragging its icon to the Trash.
When the Trash icon is highlighted, releasing the mouse button removes
the diskette’s icon from the window and ejects the diskette (alternatively,
a dialog box may be displayed with instructions to manually eject the
diskette).

Files are often stored on a diskette. Handling diskettes carefully is im-
portant because they store files in a magnetic format that is vulnerable to
dirt, heat, and magnets. Observing the following rules will help to en-
sure that your diskettes give you trouble-free service:

1. Keep diskettes away from electrical and magnetic devices such
as computer monitors, television sets, speakers, and any type of
magnet.

2. Do not expose the diskette to either extreme cold or heat.

3. Store diskettes away from dust, dirt, and moisture.

4. Never touch the diskette’s magnetic surface.

proper handling of
diskettes

Trash
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Practice 2 ���������������������������
In this practice you will create a folder, copy a file, rename a file, make a file read-only, delete a file, and
recover a deleted file. The following instructions assume that you have a diskette that contains files.

!!!!! CREATE A FOLDER
a. Insert the diskette into the drive. After a few seconds, an icon for the diskette is displayed.

b. Double-click on the diskette’s icon.

c. On the Finder Menu bar, click on the File menu. The File menu is displayed.

d. Point to the New Folder command. The command is highlighted.

e. With New Folder highlighted, click the mouse button to select the command. A new folder
icon is displayed in the diskette’s window.

f. Type the name Temporary to replace the default name and press Return. The diskette now
contains a folder named Temporary.

@@@@@ COPY A FILE
a. Locate a file in the diskette’s window.

b. While holding down the Option key, drag (do not release the mouse button) the file’s icon
over the Temporary folder icon until the folder icon is highlighted. Notice the plus sign next
to the pointer as you drag the icon. This indicates that the file will be copied.

c. Release the mouse button. A dialog box is temporarily displayed saying the file is being
copied. A copy of the file now exists in the Temporary folder on the diskette.

##### RENAME THE COPIED FILE
a. Double-click on the Temporary folder icon. The icon for the file copied in the last step is

displayed in a window.

b. Click once on the file’s name (not the icon) to select it. After a moment, a box appears around
the name and the name is highlighted.

c. Enter a new name for the file and then press Return.

$$$$$ CREATE A READ-ONLY FILE
a. Click on the new file’s icon to select it if it is not already highlighted.

b. On the Finder Menu bar, click on the File menu and then point to the Get Info command. A
submenu is displayed.

c. Click on the General Information command. A dialog box is displayed:

1. Click in the Locked check box. The file is now read-only and no changes may be
saved.

2. Close the Info dialog box by clicking on its Close box ( ).

%%%%% TRY TO RENAME A READ-ONLY FILE
Click on the file’s name. Notice that a box does not appear around it. The file cannot be
renamed because it is read-only.

^̂̂̂̂ DELETE A FILE
a. Drag the file’s icon over the Trash icon on the Desktop until the Trash icon is highlighted.

b. Release the mouse button. The file is deleted.
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&&&&& RECOVER A DELETED FILE
a. Double-click on the Trash icon. A window with recently deleted files is displayed.

b. Drag the icon of the file you deleted in the previous step over the diskette’s icon. You may
need to move the Trash window by dragging its Title bar to see the diskette icon.

c. Once the diskette icon is highlighted, release the mouse button. The file is moved from the
Trash to the diskette.

d. Close all open windows.

***** REMOVE THE DISKETTE
a. Drag the diskette icon over the Trash icon.

b. Once the Trash icon is highlighted, release the mouse button. The diskette is ejected. If a
dialog box is displayed with instructions to manually eject the diskette, select OK in the
dialog box and then manually eject the diskette from the drive.

 2.10 Initializing a Diskette
A new diskette may need to be initialized before it can be used. Initial-

izing a diskette, also called formatting, prepares it to receive data. The
steps for initializing a diskette are:

1. Place the diskette to be initialized into the drive.

2. Select the Erase Disk command from the Special menu on the
Finder Menu bar. A dialog box is displayed:

A name for the diskette and a format type
are entered in this dialog box

3. Type a descriptive name for the diskette in the Name entry box.

4. Select the Macintosh OS Standard 1.4 MB option from the
Format pop-up menu if it is not already displayed.

5. Select the Erase button. When the initialization process is com-
plete, the dialog box is removed from the screen and the
diskette’s icon on the Desktop reflects its new name.

6. Remove the diskette by dragging its icon to the Trash.

formatting
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Practice 3 ���������������������������
In this practice you will initialize a diskette. This practice assumes that you have a diskette for initializing.
Note that any data on the diskette will be lost.

!!!!! INITIALIZE A DISKETTE
a. Place the diskette into the drive. After a few seconds an icon for the diskette is displayed.

b. Click on the diskette’s icon to select it if it is not already highlighted.

c. On the Finder Menu bar, select the Erase Disk command from the Special menu. A dialog
box is displayed:

1. In the Name entry box, type your first and last name.

2. In the Format pop-up menu, click once on the arrows ( ) to display a list of options.

3. Click on the Macintosh OS Standard 1.4 MB option.

4. Click on the Erase button. Initializing the diskette may take a few seconds to a few
minutes.

@@@@@ REMOVE THE DISKETTE

 2.11 Creating Backups
A backup is a copy of a file or diskette. Although it is easy to create

backups of a file or diskette, many people do not take the time to do so.
However, the few minutes it takes to backup a file could save hours if
the file is damaged or deleted and must be recreated.

Because any data on a diskette can be overwritten, a diskette that con-
tains backup files should be write-protected so that the data cannot be
changed. A diskette is write-protected by sliding the write protect tab on
the back of the diskette upward:

write protect tab

This diskette has been write protected because the
write protect tab has been pushed up

Keeping backup diskettes in a different location than the original cop-
ies is important because it lowers the chance of both copies being de-
stroyed. For example, if you keep your AppleWorks data diskettes in
the computer lab, keep a backup copy at home. Businesses often store
their backup copies in fireproof safes, safe deposit boxes at a bank, or at
a company that provides safe “off-site” storage for computer data.

Moving the write protect tab to its original position removes write-
protection allowing for changes to be made to the data.

write-protected

storing backups
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 2.12 Using Online Help
Online help can be used to explore the features of the Mac OS. Selecting

the Mac Help command from the Help menu on the Finder Menu bar
displays the Mac Help window:

The left side of the window displays a list of topics to choose from.
Selecting a topic displays a list of subtopics in the right side of the win-
dow. Clicking on one of the subtopics displays the information about
that item.

If the topic you are looking for is not in the list, you can type a word to
search for in the entry box at the top of the window and then select the
Search button. Clicking on the Close box closes the Mac Help window.

 2.13 Finding Files
At times you may not know which folder a file is in, or you may only

know partial information about a file’s name. When this occurs, you can
use the Find command from the File menu to start the Sherlock 2 applica-
tion that comes with the Mac OS:

Sherlock 2
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The location of a file is found using this dialog box

A file can be found by entering the complete file name or a partial file
name in the entry box at the top of the window and then clicking on the
Search ( ) button. The contents of the computer is searched and the
location is displayed. Clicking once on a found file displays its location
in the bottom of the window. Double-clicking on a found file displays
that file.

It is also possible to find a file when the entire name is unknown, if
some of the text contained in the file is known. For example, a word pro-
cessor file with an unknown file name that contains the text “March 18,
2002 Meeting Agenda” can be located by entering the text in the entry
box at the top of the window, selecting the Contents radio button, and
then selecting the Search ( ) button.

Practice 4 ���������������������������
In this practice you will use the online help and Sherlock 2.

!!!!! START ONLINE HELP AND VIEW INFORMATION ON ICONS
a On the Finder Menu bar, select the Mac Help command from the Help menu. The Mac Help

window is displayed.

b. Click on Basics in the list. A list of subtopics is displayed in the right side of the window.

c. Click on “About icons and the Desktop” subtopic. The requested information is displayed.

d. After reading the information, close the window.

@@@@@ FIND A FILE
a. On the Finder Menu bar, select the Find command from the File menu. The Sherlock 2

application is started and its window is displayed.

b. Type Read Me in the entry box at the top of the window.
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c. Click on the Search ( ) button. The contents of the hard disk is searched, and the location
of any file with Read Me in its name is displayed.

d. Close all open windows.

##### SHUT DOWN THE COMPUTER
On the Folder Menu bar, select the Shut Down command from the Special menu.

Chapter Summary

This chapter introduced the Macintosh operating system and some of
its applications. Mac OS is an operating system with a graphical user
interface (GUI).

A mouse is an input device used to select an object on the screen by
pointing to the object and then pressing the mouse button once (click-
ing). Some objects are selected by double-clicking, which is pressing the
button twice in rapid succession. Dragging is the technique of holding
down the mouse button while moving the mouse.

Once the Mac OS is running, the Desktop is displayed. The Desktop
contains the Finder Menu bar and icons that represent items in the com-
puter. The Apple and Application menus are located at the top of the
Desktop.

Applications and documents are displayed in their own windows. All
windows have similar features such as a Title bar and the Close, Zoom,
Collapse, and Size boxes.

Dialog boxes are used to supply information needed to execute a com-
mand. Common options found in dialog boxes are buttons, entry boxes,
check boxes, radio buttons, and pop-up menus. A default option is an
entry or option that has already been selected for you. If no other op-
tions are selected, the default options are used when the Return key is
pressed.

The Finder application maintains the Desktop and the files and fold-
ers in the computer. It is always running when the computer is on.
Folders are used to store and organize related files. The contents of a
folder are displayed by double-clicking on its icon.

The Shut Down command from Finder’s Special menu should always
be used to turn off the computer when you are finished working with it.

Finder allows files and folders to be copied and moved using a method
called drag and drop. Folders are created using the New Folder com-
mand from Finder’s File menu. Read-only files cannot have changes made
to them. Files and folders are deleted by dragging them to the Trash icon.
An alias can be created on the Desktop to quickly display a file or start a
program.

When a file is deleted it is moved to the Trash. Deleted files can be
recovered from the Trash. Files are permanently removed from the Trash
using the Empty Trash command from Finder’s Special menu making
more space on the hard disk.

Mac OS

GUI

mouse
clicking

double-clicking
dragging

Desktop
Finder Menu bar

Apple menu, Application
menu

window
features of a window

dialog box
options in a dialog box

Finder

folder

drag and drop
copying, moving

deleting files and folders
read-only files

alias

recovering deleted files

turning off the computer
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A diskette icon is displayed on the Desktop when a diskette is inserted
in the drive. Double-clicking on the icon displays the contents of the dis-
kette. A diskette is ejected by dragging its icon to the Trash. Diskettes
should always be handled carefully to avoid problems.

The Erase Disk command from Finder’s Special menu is used to
initialize a new diskette. Initializing a diskette prepares it to receive data.

Backing up a file is important because it could save hours of extra work
if the file is damaged or deleted and must be recreated. Write protecting
backup diskettes keeps the data on the diskette from being overwritten.
Backup diskettes should always be stored in a different location than the
original copies.

Online help and the Sherlock 2 application provides information about
the operating system and locates files on the computer, respectively.

initializing a diskette

using a diskette

backups
write protecting

MAC OS online help
Sherlock 2
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Vocabulary

Alias   An icon on the Desktop used to display a file
or start a program when double-clicked.

 Apple menu   Displays a list of available Mac OS
applications.

Application menu   Used to switch between open
applications.

Backup   A copy of a file or diskette.

Booting   The process by which Mac OS is loaded into
the computer’s memory from the hard disk.

Button   A dialog box option that initiates an action
when clicked.

Cancel button A dialog box option used to remove
the dialog box without applying any options.

 Check box   A dialog box option used to select or
deselect an option.

Clicking   Placing the mouse pointer on an object and
quickly pressing and releasing the mouse button once.

 Close box   Removes the current window from the
screen, closes an application, or removes a dialog box.
Found in the upper-left corner of a window or dialog
box.

 Collapse box   Collapses the window so that only
its Title bar is displayed. Found in the upper-right
corner of a window.

Command   Performs specific tasks and actions.

Copying   Leaves the original file or folder in its
present location and places an exact copy in a new
location.

Default option   A typical entry or option that has
already been selected for you.

Desktop   The computer screen that is displayed when
the Mac OS is running and contains the Finder Menu
bar and icons.

Dialog box   Allows the user to choose and enter
information that is needed to complete an action.

Document   The material that you create using an
application.

Double-clicking   Placing the mouse pointer on an
object and pressing the mouse button twice in rapid
succession.

Drag and drop   A method of copying or moving
objects by dragging them to a new location.

Dragging   Holding down the mouse button while
moving the mouse.

Entry box   A dialog box option that accepts typed
information that may be needed by a command.

File   A document that is stored on disk.

Finder   A Mac OS application that maintains the
Desktop and organizes files and folders in the
computer.

Folder   Stores and organizes related files.

Formatting   See Initializing.

GUI (Graphical User Interface)   A program that
uses icons, menus, windows, and dialog boxes to
allow the user to work with applications software.

Icon   A small picture on the screen that represents
the items in the computer and are double-clicked to
run applications and perform tasks.

Initializing   Preparing a diskette to receive data.

Mac OS   The operating system for Macintosh
computers.

Menu   A list of commands.

Menu bar   A horizontal bar located at the top of an
application’s window that displays the names of pull-
down menus that contain commands.

Mouse   Input device that is used to move the mouse
pointer and perform a variety of tasks.

Mouse pointer   A shape displayed on the screen
when the mouse is in use.

Moving   Removes a file or folder from its present
location and places it in a new location.

Multitasking   Running more than one application at
a time.

Online help   Used to explore the features of the Mac
OS.

Operating System   Software that allows the user to
communicate with the computer using the keyboard
and mouse.

Pointing   Moving the mouse to place the pointer on
an icon or other object located on the screen.
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Pop-up menu   A dialog box option that displays a
list of choices to choose from.

 Radio button   A dialog box option used to select
an option from a group of options.

Read-only   A file that cannot be changed.

Renaming   Replacing an existing file or folder name
with a new name.

Scroll bar   Used to bring the unseen parts of a docu-
ment into view.

Selecting   Clicking on an object on the screen.

Sherlock 2   A Mac OS application that is used to find
the location of files in the computer.

 Size box   Used to change the size of a window.
Found in the lower-right corner of a window and

Title bar   Located at the top of a window and displays
the name of the application or document.

Trash   Stores deleted files so that they may be
recovered.

Window   The area of the screen that contains an open
application or document.

Write protect   Moving the write protect tab on a
diskette so it cannot receive data.

 Zoom box   Expands the window so that all of its
contents (if possible) are displayed. Found in the up-
per-right corner of a window.

Mac OS Commands and Buttons

as Icons command   Displays the contents of a folder
as icons. Found in Finder’s View menu.

as List command   Displays the contents of a folder
in a list that indicates the size and kind of the docu-
ment. Found in Finder’s View menu.

Empty Trash command   Permanently removes the
contents of the Trash and frees up hard disk space.
Found in Finder’s Special menu.

Erase Disk command   Initializes a diskette. Found
in Finder’s Special menu.

Find command   Starts the Sherlock 2 application that
is used to locate files in the computer. Found in
Finder’s File menu.

Get Info command   Displays the General

Information command which is used to dialog box
with an option to make a file read-only. Found in
Finder’s File menu.

Mac Help command   Displays information about
the Mac OS. Found in Finder’s Help menu.

Make Alias command   Creates an alias to a file or
application. Found in Finder’s File menu.

New Folder command   Creates a new folder in the
currently selected folder or disk drive. Found in
Finder’s File menu.

Shut Down command   Turns off the computer. Found
in Finder’s Special menu.
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Review Questions

Sections 2.1 — 2.6
1. a) What is an operating system?

b) What does GUI stand for?
c) What is a GUI?

2. a) What is a mouse?
b) What is pointing?
c) What is dragging?
d) What is double-clicking?

3. a) What is the Desktop?
b) What do icons represent?

4. a) What is a window used for?
b) List the features found in a window and

describe them.

5. a) What is a dialog box used for?
b) List the features that can be found in a dialog

box and describe them.

6. What is Finder?

7. a) What is a folder used for?
b) How are the contents of a folder displayed?

8. What command is used to turn off the
computer?

Sections 2.7 — 2.13
9. a) What is drag and drop used for?

b) What is the difference between copying and
moving a file?

c) List the steps required to copy a file from the
hard disk to a diskette.

10. What happens to a folder’s subfolders and files
when the folder is moved?

11. List the steps required to create a subfolder
named Letters in a folder named 2002
Documents.

12. Can changes be made to a read-only file?

13. List the steps required to delete a file.

14. a) List the steps required to rename a file.
b) List three valid file names.
c) What character cannot be used in a file name?

15. What is an alias?

16. a) What is the Trash used for?
b) What command is used to permanently re-

move the contents of the Trash?

17. a) How are the contents of a diskette displayed?
b) How is a diskette removed from a drive?

18. a) Why is it important to take good care of a
diskette?

b) List the four rules for handling diskettes
discussed in the text.

19. a) What does initializing a diskette do?
b) List the steps required to initialize a diskette.

20. a) Why should backups of data be created?
b) Why is it important to keep backup diskettes

in a different location than the originals?

21. List the steps required to write protect a diskette.

22. List the steps required to display information on
diskettes using the online help.

23. a) What is the Sherlock 2 application used for?
b) List the steps required to find the location of

a file named Harold Pinter Thesis.




